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PROJECT OVERVIEW
INSTRUCTIONAL NEED

The third-largest workforce (Newhouse & Salamon, 2020, p. 4) and generator of income and tax revenue (Newhouse & 
Salamon, 2020, p.7), the nonprofit sector continues to grow and evolve at a significant rate. According to Newhouse and 
Salamon at the Johns Hopkins Center for Civil Society Studies (2020), the nonprofit workforce increased by 18.6 percent 
between 2007 and 2017 (p. 9). Although the impact of COVID-19 led to a 13.2 percent decrease from pre-pandemic levels 
between March-May 2020 (2022), as of March 2022, the Center now projects that the overall sector will return to pre-
pandemic levels within the next eight months (2022). As the visions of these nonprofit agencies evolve, so do the duties and 
expectations of their development and communications staff. 
 
Nonprofit-related job listings with titles including “communications coordinator” and “development associate” often list graphic 
design under necessary job duties and preferred experience. At many agencies, nonprofit development and communications 
staff need to be able to design and maintain websites that cater to donors, clients, and new and existing staff. Staff also need 
to create graphics for social media and e-mail marketing campaigns. Finally, staff must be able to design event invitations 
and annual fundraising mail campaigns according to printer guidelines.
 
Yet, if staff members do not possess any education and background in graphic design, the quality and professionalism of the 
agency’s brand image often suffer. I found glaring errors when reviewing the websites and print materials of five healthcare-
related nonprofits in Southern California. Website text was difficult to read or comprehend due to the font, colors, and 
spacing. Furthermore, some print materials included unintended white margins around the edges of the page, illustrating 
that staff members did not know how to apply bleeds. Many product research, marketing, and design-related blogs like 
Sageworld (2019), Axies (2021), and Visme (2015) list a lack of knowledge of design principles like hierarchy, balance, 
and color; improper file formatting; and inaccessible design as common novice errors. These reports echo my results 
from surveying three former and current graphic designers in the nonprofit sector. Interviewees listed web accessibility 
guidelines, principles of designs, and practical technical knowledge among top knowledge and skills they wish they had 
better possessed as entry-level employees. 
 
In Usability: Principles and Practices for Designing Digital Applications, Schatter and Levinson (2013) attribute these 
knowledge gaps to the overlap of roles and diversity of disciples (xii) from which professional graphic designers come. 
Given so many novice errors are rooted in both aesthetically pleasing and functional design, Schatter and Levinson (2013) 
call for better and more training in “visual usability” or “design grounded in principles and an understanding of people” (xii). 
At the intersection of user-centered design and usability also lies accessibility. The World Wide Web Consortium (W3C)’s 
Web Accessibility Initiative (WAI) (2022) states that accessible design “improves overall user experience and satisfaction, 
especially in a variety of situations, across different devices, and for older users.” The stakes for not adhering to web 
accessibility and visual usability guidelines are high, and there can be grave legal consequences as well. 
 
Instead of hiring outside consultants or firing and rehiring new staff, nonprofit agencies can save significant time, costs, 
and resources by providing current staff members with the necessary training to help them excel at graphic design-related 
duties. This project aims to develop the training for development and communications staff to acquire the knowledge, skills, 
and experience necessary to abide by accepted industry design and accessibility standards. This project will also develop 
training to help staff members carry out tasks related to designing for the web and print production. Overall, this training 
ensures associates can fulfill their day-to-day duties effectively, helps nonprofit agencies enhance their visual brand images, 
and reduces the costs of hiring outside consultants for troubleshooting and additional support.

DELIVERY METHOD

This course will be delivered through computer-based training (CBT) eLearning modules on accessibility, file types, and 
design to reach as many learners as possible. SCORM-compliant means that agenceis to fit hteir own LMSs. Given their 
diverse array of responsibilities, learners can take this course at their own time and own pace. LeaIners will also receive aids 
during the training to help them learn, practice, and retain their new knowledge, skills, and experience. 
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TARGET LEARNER PROFILE
PRIMARY AUDIENCE
Nonprofit development staff

SECONDARY AUDIENCE
Development staff managers
Freelancers
Instructional designers
Entry-level graphic designers

GENERAL LEARNER 
CHARACTERISTICS
Experience: Entry- and mid-level 
Education: Bachelor’s degree
Design-Related KSAs: Beginner 
to intermediate experience with little 
to no formal design education

PREREQUISITE SKILLS
Project Management
Mac/PC Platforms 
Email Marketing
Social Media
Website Management
Canva
Adobe Creative Suite

ATTITUDINAL CHARACTERISTICS
Learners are motivated by:
• salary and job security
• public-facing work
• meaningful agency impacts
• professional growth
• future opportunites

TOP 3 COMMON ERRORS
Low accessibility
    • No knowledge of WAI’s 	  
    perceivable guidelines 
   (e.g., low color contrast)
Design knowledge gaps
    • Issues with alignment,  
    hierarchy, balance, and scale
Incorrect file formatting
    • Color profiles   
    • Image resolution
    • Margins and bleeds
    • Web and print file types

OVERVIEW

In today’s world, the KSAs of nonprofit development staff encompass many different 
professional fields. In addition to event planning and fundraising, staff members often 
design agency websites, social media assets, e-mail marketing campaigns, print 
advertisements, and event invitations. To be successful, staff members must have 
a comprehensive understanding of graphic design. Yet, without formal education 
or prior experience, staff members struggle to apply design principles, differentiate 
between web and print file specifications, and design accessibly for a diverse range 
of audiences. With their time and services already being pulled in multiple directions, 
they also struggle to effectively apply outside feedback when revising their designs. 

CONTEXTUAL ANALYSIS

	 ORIENTING CONTEXT
Learner Goals: Learners want to successfully complete their graphic design-
related job tasks without error and become adept graphic designers. 
Training Purpose: This instruction equips learners with the knowledge and skills 
necessary to abide by industry design standards and W3C’s Web Acessibility 
Initiative’s (WAI)’s Web Content Accessibility Guidelines (WCAG). This instruction 
will also train learners how to format their files correctly according to web and print 
specifications.
Accountability: Attitudinal characteristics relating to professional growth along with 
the direct consequences of their public-facing work hold learners accountable. 
Potential Misconceptions: New technology, terminology, and tasks that require 
memorization and dexterity may rouse insecurity and confusion. Time constraints 
alongside a steep learning curve may cause learners to feel unmotivated and 
less invested. Because these factors could decrease the chances of on-the-job 
knowledge transference, training will employ practice activities, job aids, and self-
reflection questions to help increase learner confidence and post-training success.

	 INSTRUCTIONAL CONTEXT
Because learners wear so many different hats at their jobs and take on a range 
of tasks each day, this training will be delivered through self-paced eLearning 
modules to offer learners agency in managing their time and learning progress.

	 TRANSFER CONTEXT
Learners will directly apply design knowledge to their daily tasks, which include the 
creation of social media posts, event flyers, website banners, and e-newsletters. 
Learners will be given job aids following the instruction for additional support. 

	 TECHNOLOGY INVENTORY
Learners have access to cell phones and desktop computers along with printers.  
Learners subscribe to Adobe Creative Suite along with Canva. They also have 
company social media and website logins.

TARGETED SPONSORING ORGANIZATIONS

This training targets nonprofit agencies along with freelancers, instructional design-
ers, and other small business employees handling a myriad of tasks. The missions 
of these kinds of organizations often support local communities. To meet their annual 
budgets, these agencies rely on donations through seasonal web and print fundrais-
ing campaigns along with annual fundraising events. Nonprofit development staff 
members usually report to CEOs, development directors, and boards of directors, 
which help advance agencies’ missions by managing their future and day-to-day 
decisions.
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RLO DESIGN & DEVELOPMENT DETAILS
COURSE TERMINAL OBJECTIVES

1.   Using Adobe Creative Suite, create designs that adhere to ten principles of design (Emphasis, Hierarchy, Balance, •   
Alignment, Contrast, Proportion, Movement, White Space, and Unity). 

2.   Using Adobe Creative Suite, create designs that adhere to the World Accessibility Initiative’s (WAI)’s perceivable Web 
Content Accessibility Guidelines (WCAG). 
	
3.   Using Adobe Creative Suite, create, alter, and save files according to designated web and print specifications. 	

MODULE TERMINAL AND ENABLING OBJECTIVES

Using Adobe Creative Suite, create, alter, and save files according to designated web and print specifications. 
	 Enabling Objectives: 
	 •   Differentiate between print and web file specifications, including color modes, image resolutions, units of
	 measurements, and file formats. 
	 •   Create, alter, and save files correctly using these specifications. 
	 •   Test, correct, and/or improve files by previewing designs though web applications and print proofs. 

RLO OBJECTIVE

Differentiate between print and web file specifications, including color modes, image resolutions, units of measurements, 
and file formats. 

COURSE LEARNING ASSESSMENT

•   Pre-assessments
•   Practice activities with formative feedback
•   Scenario-based performance simulations with formative and summative feedback

RLO LEARNING ASSESSMENT

•   Pre-assessment confidence check
•   Knowledge check with multiple-choice questions 

LEARNING THEORIES

	 INTERACTIVITY, ANDRAGOGY, AND TRANSFORMATIVE LEARNING
The design of this RLO will be informed by explorative learning and constructivist learning theories. As part of efforts to better 
involve the learner and invite deeper engagement, learners will browse topic carousels, flip flashcards, and click accordion  
menus to glean new knowledge. Both the freedom to explore and the self-directed pace reflect key assumptions about adult 
learning. Including animated video narratives that illustrate the real-life application and importance of this knowledge will 
also invite more of the “aha” moments that live at the heart of transformative learning theory. All in all, this level of interactivity 
aligns well with the terminal objective and promotes long-term integration.

	 HORTON’S ABSORB-DO-CONNECT ACTIVITIES  
My instruction will structure activities through William Horton’s “absorb-do-connect” methods, as outlined in his 2006 
book, E-Learning by Design. In “absorb” activities, learners “absorb” new information (Horton, 2006, p.51). On the whole, 
these activities may sound passive, but they actually require learners to remain “mentally active” (Horton, 2006, p.51). 
Incorporating “connect” activities and interactivity into “absorb” activities helps learners better comprehend introductory 
knowledge and connect it to prior experience. Additionally, including “connect” activities at the beginning of the course and 
following the knowledge check will help learners gauge their current KSAs and reflect on their in-progress learning. By 
asking learners to reflect on and connect their past experiences and knowledge, they will hopefully recognize the value of 
their new learning and better integrate it into their long-term memories.
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RLO DESIGN & DEVELOPMENT DETAILS
Sequenced together, these activities help transition new KSAs from working load into long-term memory, scaffold learning, 
and align instruction, providing learners with a clear path to success.

	 MAYER’S MULTIMEDIA PRINCIPLES
Mayer’s multimedia principles will be especially helpful for creating the animated videos featured in this RLO. Though close 
captions will be available,  I will include voiceover rather than on-screen text to adhere to temporal contiguity, modality, and 
multimedia principles. Conversational dialogue and use of a narrative will bolster conformance to personalization and voice 
principles. The sequencing of these videos will adhere to the pre-training principle to reinforce these new concepts. 

	 MICROLEARNING
Like chunking, microlearning breaks down learning into smaller, digestible chunks to reduce cognitive load and invite deeper 
knowledge retainment. While guidelines for print and web files could encompass a myriad of complex and diverse topics, 
this RLO focuses on providing learners with a basic and practical foundation. The RLO is also flexible and affordable for a 
broad range of sponsoring organizations, whose needs and resources vary wildly.
	
MEDIA

Text, animated video with audio, visual graphics (photos and icons)

508 ACCOMMODATIONS 

This RLO includes a navigational menu, progress bar, and detailed automatic feedback. The learner also controls their 
pace and navigation. Following the WCAG Perceivable principle, this course’s color scheme uses a high color contrast and 
multiple visual signifiers for text hyperlinks. 
	
RLO COURSE STRUCTURE DESCRIPTION

1 Unit (Web and Print File Types)
6 Subtopics (Introduction, Image Resolution, Color Modes, Units of Measurement, File Formats, Altering Files) 
Chunked into: 
1.		  Prerequisite Knowledge
2.		  Introduction
3.		  Image Resolution
4.		  Color Profiles 
5.		  Units of Measurements 
6.		  File Formats
7.		  Altering Files
8.		  Knowledge Check (4 total slides: 3 questions, results slide)

COURSE SEAT TIME

Approximately four weeks

RLO SEAT TIME

30 minutes

NUMBER OF SCREENS

13

KNOWLEDGE CHECKS OR OTHER ASSESSMENTS 

1 dichotomous (Y/N) confidence check question with automatic feedback.
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3 multiple-choice knowledge check questions. Unlimited attempts allowed.  Automatic formative and summative feedback 
will be provided. 

RLO NAVIGATION 

	 Close pop-up windows

 Progress bar

 Navigation menu (closed)

 Navigation menu (open)

 	 Multiple-select dropdown tab 

	 Button #1 layout/color (dark background)

	 Button #1 hover state

	 Button #2 layout/color (light background)

	 Button #2 hover state 

Buttons will be used to control the entire navigation of the course. (Y/N answers, Back, Next, Reply, Exit Course, Try Again)

SCREEN LAYOUTS

RLO DEVELOPMENT TOOLS

Mindmeister, Microsoft Word, Adobe Photoshop, Adobe Illustrator, Adobe XD, Adobe Audition, Adobe InDesign, Vyond, 
Articulate Storyline

OWNERSHIP

Winona León will develop and maintain this course for her 767 coursework and online portfolio. 

RLO DESIGN & DEVELOPMENT DETAILS
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DEVELOPMENT TIME OF RLO

6 weeks development time/60 hours for visual design mockups, text-based storyboard, XD prototype, video development, 
Articulate Storyline conversion, and user testing 

SUPPORT REQUIREMENTS FOR RLO AND COURSE

RLO Development requires subscriptions to Adobe Creative Suite, Vyond, and Articulate Storyline. This RLO will be web-
based and accessible from a hyperlink on common Internet browsers such as Chrome or Firefox. Users will need a desktop 
computer with wi-fi. 

RLO DESIGN & DEVELOPMENT DETAILS
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TOPIC ANALYSIS
TOPIC ANALYSIS

Goal: Create, alter, and save files according to designated web and print specifications.

1.   Differentiate between print and web file specifications. 
	 1.1.   Image Resolution
		  1.1.1.   Web: Web files should be set at 72 ppi (pixels per inch) to ensure pixels remain barely discernable
		  and graphics are clear.
		  1.1.2.   A changing future: As technology continues to rapidly improve, screen displays are also improving.
		  Still, unless, you’re working with some very web specific guidelines, 72 ppi is still your best bet as smaller
		  file sizes reduce loading times.
		  1.1.3.   Print: Given their physicality, print files should be set at 300 dpi (dots per inch) to ensure graphics
		  remain crisp and readable.
	 1.2.   Color Profiles
		  1.2.1.   Print files should be set in a CYMK (cyan, yellow, magenta, key/black) color mode.
				    Because this color mode uses layers of dyed pigments, or inks, to produce your
				    designated colors, this 4-color process color mode is subtractive; together, all four colors
				    produce black while their absence will produce white.
				    True Black: This term commonly refers to the richest and most concentrated shade of
				    black achievable in a CYMK document. The most used values are C  – 75, Y – 68, M –
				    67, K – 90, but check with specific printers to ensure their guidelines don’t vary.
		  1.2.2.   Web files should be set in an RGB (red, green, blue) color mode.
				    Using colors of light to display colors on a screen, this color mode is additive; together,
				    the three primary colors of red, green, and blue will produce white while the absence of
				    color will produce black.
	 1.3.   Units of Measurements
		  1.3.1.   Inches: To accurately view the size of a print image, print files should be measured in inches.
				    Margins & Bleeds
		  1.3.2.   Pixels: Given that digital images are measured in pixel density (pixels per inch) on a screen
		  display, it’s easiest to measure web files in pixels. Each of these square units display a single color.
				    Margins & Padding
		  1.3.3.   Points: Points are commonly used to measure your size of type in a text box or document.
		  1.3.4.   Picas: Equaling about 1⁄6 of an inch, picas are most often used to measure column width and
		  depth in typography.
	 1.4.   File Formats
		  1.4.1.   JPG: A jpg file is the best format to save a web file that can be easily compressed, accessed, and
		  shared. Cameras often save images as this file type.
		  1.4.2.   PNG: A png file is the best format to save a web file with a transparent background and/or sharp
		  contrast values (such as an illustration) given its lack of compression.
		  1.4.3.   PDF: A pdf file is the best format to save a print document file that can be easily accessed and
		  shared.
		  1.4.4.   GIF: A gif file is the best format to save an animated web file that can be easily accessed and
		  shared.
		  1.4.5.   TIF: A tif file is the best format to save a high-quality print file with multiple pages and/or a
		  transparent background. A lossless image file, they do not compress images, meaning they create larger
		  file sizes.
2.   Learners can create, alter, and save files correctly using these specifications.
	 2.1.   Creating files
		  2.1.1.   Correctly set an image’s size, resolution, color mode when creating a new file In Adobe Creative
		  Suite.
				    Note: Resolutions don’t matter in Vector-based programs like Illustrator.
				    Note: Be sure to use margins and guides to create distinct layouts.
		  2.1.2.   Set bleeds for print documents to ensure your image will print to the paper’s edge without any
		  margins.
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TOPIC ANALYSIS
	 2.2.   Altering files
		  2.2.1. Color Profiles Specifics
				    Illustrator: Edit>Color Settings, Edit>Assign Profile, Edit>Edit Colors, or File>Document
				    Color Mode
				    Photoshop: Edit>Convert to Profile (preserves appearance)*
				    InDesign: Edit>Convert to Profile (preserves appearance)
	 2.3.   Image Resolution Specifics
		  2.3.1.   Photoshop: Image>Image Size
		  2.3.2.   InDesign & Illustrator: change during Export/Save process and check resolution of placed images
		  using Photoshop
	 2.4.   Units Specifics
		  3.4.1.   View>Rulers>Show Rulers if hidden
	 2.4.   Learns know to save originals and copies.		
3.   Saving FIles 
	 3.1.   Package files
	 3.2.   Save the design document by Save as or Export.
		  3.2.1.   EYou can often change color profiles and resolution as well as specific file formatting settings in
		  the Export process as well.
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RLO OUTLINE
1.   Title Page
2.   Confidence Check
	 a.   Ask learners about prior exprience (Expert, Mid-Level, Novice) and show brief outline of course in feedback 
3.   Introduction
	 a.   Play video with story illustrating the importance of formatting files correctly. 
4.   Image Resolution: clicking on icons will open pop-up windows
	 a.   Print
	 b.   Web
	 c.   Other circumstances
5.   Color Modes: image carousel
	 a.   CYMK
	 b.   RGB
	 c.   True Black
6.   Units of Measurement: accordion menu
	 a.   Inches
		  i.   Print
		  ii.  Discuss margins, padding, and bleeds
	 b.   Pixels
		  ii.   Web
		  ii.   Discuss margins and padding. 
	 c.   Points
		  i.   Typography
		  ii.   Discuss legible (9+ points) and large-size (18+ points) type.
	 c.   Picas
		  i.   Typography
7.   File Types 
	 a.   JPG
	 b.   PDF
	 c.   PNG
	 d.   GIF
	 e.   TIF
8.   Saving Files 
	 a.   Play video with story illustrating the importance of saving files correctly. Show screen-captured video of
	 example. 
9.   Knowledge Check
	 a.   3 questions on web and print file; learners must choose the correct specifications. Learners should receive
	 unlimited attempts
	 e.   Summative results slide 
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PROJECT SIGN-OFF
Please sign below indicating agreement with the proposed course plan and approving start-up 
of the storyboard and development phases.

Instructional Designer

Project Manager/Sponsor



13WINONA LEÓN

8 graphic design mistakes to avoid. (2019, October 11). Sageworld. https://www.sageworld.com/blog/index
	 php/2019/10/11/8-graphic-design-mistakes-to-avoid/

Anderson, L.W. (Ed.), Krathwohl, D.R. (Ed.), Airasian, P.W., Cruikshank, K.A., Mayer, R.E., Pintrich, P.R., Raths,
	 J., & Wittrock, M.C. (2001). A taxonomy for learning, teaching, and assessing: A revision of Bloom’s Taxonomy of
	 Educational Objectives (Complete edition). Longman.

CAST (2018). Universal Design for Learning Guidelines version 2.2. Retrieved from http://udlguidelines.cast.org

Chibana, N. (2015, December 21). 19 common graphic design mistakes made by non-designers. Visme. https:/
	 visme.co/blog/graphic-design-rules

Clark, D. (2012, April 12). Miller (1920 - ) Magic number 7 plus & minus 2 – chunking. Donald Clark Plan B. Retrieved
	 from  http://donaldclarkplanb.blogspot.com/2012/04/miller-1920-magic-number-7-plus-minus-2.html 

Henry, S. (2022, March 31). Introduction to web accessibility. W3C Web Accessibility Initiative (WAI). https://www
	 w3.org/WAI/fundamentals/accessibility-intro/

Horton, W. (2012). E-learning by design (2nd edition). John Wiley & Sons.

McTighe, J., & Wiggins, G. (2005). Understanding by design (2nd edition). ASCD: Association for Supervision and
	 Curriculum Development.

Mager, Robert F. Measuring Instructional Results, or Got a Match? (2nd edition), Lake Publishing Company, 1984.

Mager, Robert F. Preparing Instructional Objectives (3rd edition), CEP Press, 1997.

Mayer, Richard E. Cognitive theory of multimedia learning: implications for design principles.” The Cambridge
	 Handbook of Multimedia Learning, 2005, pp. 31–48., https://doi.org/10.1017/cbo9780511816819.004.

Newhouse, C. & Salamon, L. (2020). The 2020 nonprofit employment report. Nonprofit Economic Data Bulletin no. 48.
	 Johns Hopkins Center for Civil Society Studies. Available at ccss.jhu.edu.
 
Newhouse, C. & Salamon, L. (2022). Nonprofit employment during the covid-19 crisis. Baltimore: Johns Hopkins
	 Center for Civil Society Studies. Available at ccss.jhu.edu.

Schlatter, & Levinson, D. (2013). Visual Usability: Principles and Practices for Designing Digital Applications. Elsevier
	 Science & Technology.

Solomon, H. (2018, November 30). Cognitive Load Theory (John Sweller). Educational Design. Retrieved from https:/
	 www.instructionaldesign.org/theories/cognitive-load/

Thalheimer, W. (2015, January 29). Video on learning objective. WorkLearning. Retrieved from https://www
	 worklearning.com/2015/01/29/video-on-lobjs/

Top 5 common graphic design mistakes to avoid. (2021, September 6). Axies. https://axies.digital/common-graphicdesign
	 mistakes/
	

REFERENCES


